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Creating a Research Poster 
 
 
What is a Research Poster? 
 
A research poster is an organized, visual display of the main points of your research or creative project. 
Typically, you present your poster in a poster session at a conference or seminar. Conference or seminar 
attendees will walk by your poster, study its contents, and ask you questions. You should be prepared to 
answer questions and to explain your project one-on-one frequently throughout the poster session.  
 
To put it simply, a research poster is: 

• A way to summarize and visualize your own research or creative work on a single large display 
• Your opportunity to capture and convey the main points of your research to your audience 

 
How you design your poster is up to you! Guidelines are offered to help you think about different 
aspects and the process of creating a poster for your research. 
 
 
Who will see it and read it? 
 
Your audience will depend on the context of the poster event. Generally, the audience is an 
assortment of colleagues, classmates, mentors, professors, and professionals as well as leaders in your 
field or a related field. 
 
People walking by may glance at your poster, stop for a few minutes, or stop longer to hear you 
present, and some may ask you questions. An effective audience-friendly poster: 

• Presents your research in an organized and visually pleasing way. Posters typically contain 
both text and graphics (charts, tables, lists, etc.). 

• Is self-explanatory. In the case that you aren't standing by your poster, or if you are otherwise 
engaged in conversation, anyone walking by should be able to view your poster and understand 
the main points of your project. 

• Is easy to read. Be sure your text and graphics are large enough that multiple people standing a 
few feet away can read your poster simultaneously. 

• Is concise. Your poster should summarize your project quickly and efficiently. Avoid long 
paragraphs. Bullet points are often very effective. Figure out how you might present parts of 
your project through graphics. You should be able to explain your poster from start to finish in 
fifteen to twenty minutes, OR those who are reading it should be able to gather the main points 
in less than five minutes. 
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Undergraduate Research Week (May 20-24, 2019) 
 
Undergraduate Research Week showcases undergraduate research and creative projects in the 
humanities, arts, social sciences, life sciences, physical sciences, and engineering. Events include oral 
presentations of student research, and presentations of research posters on Poster Day. Applications 
are due April 15 – share your research or creative project at an interdisciplinary conference!  
 
Presenting Your Poster – a few suggestions 

• Wear business casual attire. Wear comfortable shoes as you will be standing for long periods.  
• Plan a few versions of your presentation that can be given in 1-2 minutes and 2-5 minutes in 

length to accompany your poster.  
• Your verbal presentation should align with your visual presentation. You shouldn’t be jumping 

inconsistently across your poster. 
• Be prepared for frequent interruptions. Viewers will ask you questions as you go along. They do 

not wait until the end of your presentation.  
• Face your audience when speaking, but point to your poster.  
• Start with the big picture. Emphasize your project goal. Walk the viewer through all the panels 

on your poster. Make sure that you end with a take-home message that brings the viewer back 
to your big picture.  

• Remember: If it is on your poster, you should be prepared to talk about it.  
 
Posters for Research Week 

• Your poster can be sized up to 42 inches wide by 42 inches tall. 
• Your poster will be attached to a poster board with pins provided by the Undergraduate Research 

Center on Research Poster Day. 
• You can make a poster in PowerPoint and print it as a poster. 
• Posters can be printed at UCLA or at a local printer. See pages 7-8 for printer locations and pricing. 
• Posters can also be printed on standard printer paper (8.5 inches by 11 inches). Print the sections 

of your poster on standard paper, then attached each section directly to the poster board. 
Arrange the sections into columns and rows on your poster. 

 
Research Week Poster Awards and Funding Opportunities 

• UCLA Library Research Poster Grant: students from all majors can apply for a poster grant within 
the Research Poster Day application. Poster grants support the cost of research poster printing 
at the UCLA Library!  

o Apply via the Research Poser day application on MyUCLA -> Campus Life -> Survey by 
April 15. Grant recipients will be notified by April 30. 

• Dean’s Prize: students who are presenting posters for the humanities, arts, and social science 
projects can apply to be judged for a Dean’s Prize. Applications are due on April 18. Find out 
more: http://hass.ugresearch.ucla.edu/urw/awardsfunding/   
 

http://hass.ugresearch.ucla.edu/urw/awardsfunding/
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Elements of the Poster 

Posters often have the following sections, which may vary by discipline: 
□ Title 
□ Author name (your name, faculty advisor’s name) 
□ Institution  
□ Abstract 
□ Background or Introduction 
□ Hypothesis or Argument or Research Question 
□ Methodology or Approach 
□ Figures or Images 
□ Results, Discussion, and/or Conclusions 
□ Future directions 
□ References (if needed) 
□ Acknowledgements  

 
• Title: At the top of your poster, you should have a title that is brief but descriptive, and it should 

clearly indicate the nature of the project. In no more than 200 characters (approximately 30 
words, including spaces), describe your research in succinct terms, reflecting the contents of your 
abstract. Use key words, and do not use abbreviations, non-English characters, or symbols. 
Capitalize the first letter of all words in your title. However, do not capitalize article words such 
as “a,” “the,” “and,” and “of,” unless the article is the first word of the title. The title should be 
easily readable at a distance of about 4-5 feet away. It should be written in “active tense” if 
possible.  
 

• Author(s): The first name should be the name of the poster presenter; after this, the authors are 
listed in the order of contribution to the work. Indicate the “presenting” author(s) (meaning you 
and any other authors who will present the work at Undergraduate Research Week) by writing 
these names in ALL CAPITALS. If it is appropriate to your discipline to list your faculty mentor as 
an author, you should list your faculty mentor as the last author. (Be sure to ask your faculty 
mentor if you are not sure!) Do not include titles or degrees such as Dr., Ph.D., etc. 

 
• Institution: Below the list of authors, include your department and the university.  

 
• Abstract: Your abstract must be at least 100 but no more than 1550 characters (approximately 

225 words). The abstract should include introductory or background information, your argument 
or research question, the methods employed, and your results or conclusions. End the abstract 
by stating the significance of your research. Do not use symbols, non-English characters, italicized 
or boldfaced words, references, figures, or tables in your abstract. 

 
• Background or Introduction: Present any background information necessary for the reader to 

understand your poster. Start with a general introduction to the field. Be brief, but include the 
important points to be sure the reader sees the relevance of your work. Bullet points are best, 
versus big paragraphs of text.  



4 
 

• Hypothesis, Argument, or Research Question: You should clearly state what you hypothesize 
based on the background information that you provided. You can include a model or diagram 
here to help explain the question you are interested in. State briefly your approach to answering 
your hypothesis. DO NOT go into details about methods in this section.  

 
• Methodology or Approach: State briefly your methodology for answering your hypothesis or 

research question(s) (e.g. experimental methods) or your approach to crafting your argument or 
thesis (e.g. theoretical, disciplinary, etc. approach). You do not need to go into great detail here; 
it is often better to include details in figures or graphics. 
 

• Figures or Images: Here you present the data or components of your project in visual form. 
Figures may be graphs, lists, tables, photographs, illustrations, diagrams, or other relevant 
graphics. Typically, each of your figures or graphics will have a title. If it is appropriate, you should 
also include a legend for each figure or graphic. 

 
• Results, Discussion, and/or Conclusions: Here you state the results and conclusions of your 

project. Be brief and to the point. You should also indicate the significance of your project: what 
knowledge has your project added to your field? If it is appropriate, mention any alternative 
explanations for your results and possible explanations for unexpected results. 

 
• Future Directions: If it is appropriate, you should explain what you plan to do next on the project. 

Do your conclusions lead you to a new question? Are you considering trying a new method to 
answer your original question?  

 
• References: List all sources that you cite in the various sections of your poster. You should list 

your sources using the citation format appropriate to your discipline and project (MLA, APA, 
Chicago, etc.). 

 
• Acknowledgements: If you are funded by a URC program, acknowledge your respective program 

(i.e. URFP, URSP, MMUF, etc.) as well as the grant you received. Otherwise, it’s highly 
recommended you acknowledge those who assisted you on or contributed to your research, 
which includes the funding source that paid you or provided the funds used to support your 
project. 
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Designing Your Poster 
 

• Font size 
o Title – 72 point or larger 
o Author (you) – 48 point or larger 
o Headings – 48 point or larger 
o Content – 36 point or larger 
o Figure or Image captions – 20 point or bigger 

 
• Font choice 

o Choose a clear font to read: 
 Arial 
 Calibri 
 Times New Roman 

o Do not use unclear fonts – examples include: 
 Comic Sans 
 Broadway 
 Harlow 

o Do not italicize text 
 

• Visual information –  Visuals can be figures or images. You can check the relevancy of your visual 
information by listing the visuals that you would use if you were describing your project with only 
figures or images – do they contribute to your presentation, or do they distract from it? 

o Figures – These should be clearly labeled according to the format used in your field or 
discipline (ex. APA, MLA, etc.) 

o Images – Make sure that images are high resolution – they should be at least 300 dpi (dots 
per inch) to avoid blurriness, and inserted (not pasted) to retain image integrity. 
 

• Color 
o Text and background should contrast 

 Background color should make the content stand out  
 Font color should stand out but not be distracting 

o We strongly recommend that you have a white poster background with black or dark text 
and colorful, eye-catching figures. Having a white background saves ink, and posters with 
complicated background patterns are difficult for the reader to view. 
 

• Layout 
o Posters are typically read top to bottom, left to right 
o Sections should be organized by columns 
o There should be three to four columns on the poster 
o Columns should be aligned 
o Text should be aligned 
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Creating a Poster Using PowerPoint 
 
You can create a poster just like a normal PowerPoint slide—only bigger. 
 

• Set the size of ONE PowerPoint slide to the size of your poster 
Under the File menu, go to Page Setup. For the size of the slide, type in the actual size of your 
poster. Your poster can be sized up to 42 inches wide by 42 inches high. Be sure to check with 
your poster printing location to determine the maximum poster dimensions that the location can 
print.  
 
You should always set the page size before you begin laying out your poster. Otherwise, you will 
likely have to go back and revise your poster layout. 
 

• Insert text 
Add text to your poster by inserting Text Boxes (under the Insert menu) into your slide. Insert 
multiple Text Boxes for all of your different text components (title, abstract, etc.). Recommended 
font sizes are at least 72 point for your title, 48 point for your headings, 36 point for your text, 
and 20 point for figure labels. 
 

• Insert images and objects 
The best way to add an image or object is to insert it via the Insert menu. Make sure your images 
are high resolution; otherwise, they will appear pixelated once they are enlarged and printed. 
 

• Adjust spacing, alignment, and size of pictures and text 
Once you have inserted all of the poster elements, adjust the spacing, alignment, and size of 
pictures and text to create your desired layout. Make sure your poster is easy to follow. 
 

• PowerPoint Tip 
Zoom in to work on detail and zoom out to work on arrangement of parts. Some functions of 
PowerPoint may not work when you zoom out to fit the whole poster on screen. Select an area 
to work on and zoom back in to 75-100% to make adjustments. 

 
 
Resources 

• Undergraduate Research Center – Humanities, Arts, and Social Sciences Poster Guidelines and 
Template: http://hass.ugresearch.ucla.edu/urw/guidelines/#tab-id-3  

• UCLA Logo and brand identity information from the UCLA Library:  
http://guides.library.ucla.edu/c.php?g=223540&p=1480860  
(Note: If you use the UCLA logo, it needs to be the official logo!) 

• Ten simple rules for a good poster presentation: 
https://www.ncbi.nlm.nih.gov/pmc/articles/PMC1876493/  

• A web resource for poster assembly presentation: 
http://www.swarthmore.edu/NatSci/cpurrin1/posteradvice.htm  

http://hass.ugresearch.ucla.edu/urw/guidelines/#tab-id-3
http://guides.library.ucla.edu/c.php?g=223540&p=1480860
https://www.ncbi.nlm.nih.gov/pmc/articles/PMC1876493/
http://www.swarthmore.edu/NatSci/cpurrin1/posteradvice.htm
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UCLA & Westwood Poster Printing Locations and Rates  
 
If you would like to have your poster printed, contact one of the following printing locations. Please note 
that due to the high volume of posters being printed, you should allow for ample turnaround time!  
 
Please also note that some locations may be fully booked by the time you contact them. Contact the 
printing location ahead of time to ask about printing availability and to schedule the time when you will 
drop off your poster file for printing. Be sure to ask your faculty mentor about preferred printing 
locations and any poster printing funds that are available.  
 
Prices may change at the discretion of the printer – remember to confirm pricing prior to printing!  
 
 
ASUCLA Bruin Custom Print Shop 
Ackerman Union on the A-Level (opposite Bruin Buzz) 
(310) 825-3825 
$6 per square foot (matte) 
$2.50 per square foot (poster paper) 
$7.50 per square foot (glossy) 
42 in. x 42 in: $30.63 (standard poster paper), $73.50 (matte), $91.88 (glossy) 
 
 

UCLA Design and Media Arts 
Broad Art Center, fourth floor 
issag@arts.ucla.edu 
https://support.dma.ucla.edu/print/ 
42 in. x 42 in.: $81.12 (matte) 
42 in. x 42 in.: $83.02 (luster) 
printing set-up fee may apply 
 
 

UCLA Life Science Illustration Office 
Hershey Hall, Room 210 
illustration@lifesci.ucla.edu 
$13 per linear ft  
42 in. x 42 in.: $68 (glossy) 
 
 

UCLA School of Engineering 
Boelter Hall, Room 2685 
https://www.matserv.ucla.edu/poster-printing/  
$7.50 per square foot (glossy) 
42 in. x 42 in.: $91.88 (glossy) 
Mailing tubes in 36”. 42” and 48” lengths ( 3” diameter) at $3.50/ea 
 

 

mailto:issag@arts.ucla.edu
https://support.dma.ucla.edu/print/
mailto:illustration@lifesci.ucla.edu
https://www.matserv.ucla.edu/poster-printing/
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UCLA Mail, Document & Distribution Services 
555 Westwood Plaza, Level B, Los Angeles, CA 90095 
(310) 825-0433 
mdds@mdds.ucla.edu 
https://www.mdds.ucla.edu/document-services 
42 in. x 42 in.: $111.02 (matte or satin) 
 
 

UCLA Psychology Technical Services 
Franz Hall A544 
Open Monday-Thursday 
(310) 825-3430 
techservices@psych.ucla.edu  
http://www.psych.ucla.edu/departmental-units/facilities/technical-services/graphics-and-media  
Contact via email with initial printing inquiry in advance to see if they have the bandwidth to print your 
poster. This printer reaches capacity quickly and may not be able to print your poster. 
$11.04 per linear square foot (semi-gloss) 
42 in. x 42 in.: $38.65 (semi-gloss) 
 
 

Copymat Westwood 
10919 Weyburn Avenue, Los Angeles, CA 90024 
Open Monday – Friday 9AM – 5PM 
www.copymatwestwood.com  
printit@copymatwestwood.com  
(310) 824 5276 
$7.50 per sq foot (satin, semi-gloss, or matte) 
42” x 42”: $90 (satin, semi-gloss, or matte) 
Arrangements can be made outside of normal business hours for pickup 
Same day turnaround is available if needed at no extra cost 
 
 

FedEx Office (formerly Kinko’s) in Westwood 
10924 Weyburn Ave, Los Angeles, CA 90024 
http://local.fedex.com/ca/los-angeles/office-0897/ 
(310) 475-0789 
$7.50 per square foot (matte) 
$7.96 per square foot (heavy coat) 
$12.50 per square foot (photo glossy) 
42 in. x 42 in.: $91 (matte), $97.50 (heavy coat), $153 (photo glossy)  
UCLA students will receive an additional 10% discount  
 
 
 
 

https://www.mdds.ucla.edu/document-services
mailto:techservices@psych.ucla.edu
http://www.psych.ucla.edu/departmental-units/facilities/technical-services/graphics-and-media
http://www.copymatwestwood.com/
mailto:printit@copymatwestwood.com
http://local.fedex.com/ca/los-angeles/office-0897/
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Research Poster Examples 
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